
   

E
nglish
Installation Guide

This is a hypertext-enabled document. All references to page numbers are live links. 
Just click on the page number, and the document will go there automatically!

PCI
Open Architecture Synthesis, Effects, and Audio I/O



  

E
ng

lis
h

              
The FCC Caution

This device complies with Part15 of the FCC Rules. Operation is subject to the following two conditions: (1) This 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation.

The FCC Regulation Warning

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of 
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

Unauthorized changes or modification to this system can void the user's authority to operate this equipment.

Canada

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numerique de la classe B est conforme a la norme NMB-003 du Canada.

CE mark for European Harmonized Standards

CE mark which is attached to our company’s products of AC mains operated apparatus until December 31, 1996 
means it conforms to EMC Directive (89/336/EEC) and CE mark Directive (93/68/EEC).

And, CE mark which is attached after January 1, 1997 means it conforms to EMC Directive (89/336/EEC), CE mark 
Directive (93/68/EEC), and Low Voltage Directive (73/23/EEC).

Also, CE mark which is attached to our company’s products of battery operated apparatus means it conforms to EMC 
Directive (89/336/EEC) and CE mark Directive (93/68/EEC).

Trademarks

ADAT, ADAT XT, and BRC are registered trademarks of Alesis, Inc.; RD-8 and CX-8 are registered trademarks of the 
Fostex, Inc.; MDA-1 is a registered trademark of Panasonic, Inc; Apple and MacOS are registered trademarks of Apple 
Computer, Inc.; Windows 95 and Windows 98 are registered trademarks of Microsoft Corp. All other company names, 
brand names, product names, and names of formats etc. are the trademarks or registered trademarks of their 
respective owners.

Licensor Indications

Certain synthesis algorithms in this product were developed under license of physical modeling patents (listed in 
http://www.sondius-XG.com) owned by Stanford University, USA, and by Yamaha Corporation. Sondius-XG 
Technology rights provided under license from Staccato Systems, Inc. (www.Staccatosys.com). 

Third-Party Products

Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a 
recommendation. Korg assumes no responsibility with regard to the performance or use of these products.

Manual Version: 7/23/01

Copyright 1999-2001 Korg Inc. All rights reserved.

Onscreen graphics by GAS Brand Design.

KORG INC.

Tested to comply 
with FCC Standards

FOR HOME OR OFFICE USE
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OASYS PCI
Thank you!

Thank you for purchasing the Korg Soundlink DRS OASYS PCI.

The OASYS PCI integrates high-quality synthesis, effects processing, and 
computer audio input and output into a single, professional PCI audio card–the 
perfect complement to any MIDI sequencer or software-based digital audio 
workstation.

State of the art DSP synthesis
The OASYS PCI’s synthesizers represent a continual evolution from Korg’s 
pioneering efforts in DSP synthesis, with many improvements and additions. 

Synthesis algorithms are plug-ins loaded from disk, allowing easy upgrades and 
expansion. Korg and third-party sound developers can easily introduce new 
algorithms, or even entirely new types of synthesis.

Incredible effects processing
The OASYS PCI starts with all of the effects of the award-winning Korg Trinity 
workstation, and builds from that foundation. Effects can be used to process the 
onboard synthesizer, tracks from digital audio programs, and live audio inputs, 
and can be used on channel inserts, as sends, and on output busses. As with 
synthesis algorithms, all effects are plug-ins loaded from disk, allowing for easy 
expansion in the future.

Professional, multi-format analog and digital I/O
The OASYS PCI features a total of 12 inputs and outputs - stereo analog, stereo 
S/PDIF, and eight-channel ADAT optical. All inputs and outputs are 24-bit, and all 
can be used simultaneously with compatible multitrack audio software. Word 
clock and ADAT timecode I/O allow easy integration with other digital audio 
equipment.

Seamless integration with MIDI and digital audio software
The OASYS PCI supports all major audio and MIDI standards, for compatibility 
with virtually every audio and MIDI program. 

The output of the synthesizers and effects can be recorded directly into digital 
audio software, without any external connections. The OASYS PCI Editor software 
allows configuration of all mixing, effects, and synthesis parameters, so that no 
special support is necessary from any digital audio program.
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Designed to collaborate with your CPU
You can use your favorite PowerPC or Pentium-based effects plug-ins, such as VST, 
MAS, and DirectX plug-ins, simultaneously with OASYS PCI effects and 
synthesizers.

Complete automation via MIDI
Every parameter in the OASYS PCI can be modulated via standard MIDI 
controllers, allowing easy automation of mixing, synthesis, and effects from any 
MIDI sequencer.
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About The Manuals
The documentation for the OASYS PCI is divided into several parts, as described 
below.

Installation Guide
This is the manual that you are reading right now. It provides a brief overview of 
the product, software and hardware installation instructions, and problem-solving 
resources. It is divided into four main sections. 

Introduction
The Introduction provides an overview of the OASYS PCI, including a description 
of the documentation. As museum maps say, “you are here.” 

Installation and Setup
This section describes hardware installation and audio connections, software 
installation and configuration, and integration of the OASYS PCI into different 
basic studio setups.

Getting Started
The Getting Started section walks you through loading and playing some demo 
sounds, introduces the major OASYS PCI file types, and provides an overview of 
the user interface.

Appendix
This section includes information on troubleshooting and contacting technical 
support, as well as functional specifications for the OASYS PCI.

Users Guide
The Users Guide explains the basic functionality of the OASYS PCI, and is divided 
into two main sections. It is provided in Adobe Acrobat (.pdf) format, which you 
may read online or print out, as you wish.

Using the OASYS PCI
This section offers step-by-step instructions for performing specific tasks and 
achieving specific goals with the OASYS PCI.

Look to the Using the OASYS PCI System section to answer the question, “how do 
I do this?”

Reference
This section describes every window, parameter, and menu command in the 
OASYS PCI, with the exception of algorithm-specific Patch and Effect Control 
Panel parameters. 
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Use the Reference section to answer the question, “what does this do?”

Patches and Effects Guide
This manual includes complete descriptions of the Control Panel parameters for 
each Patch and Effect. It is provided in Adobe Acrobat (.pdf) format, which you 
may read online or print out, as you wish.

OASYS PCI FAQ
FAQ stands for “Frequently Asked Questions.” The OASYS PCI FAQ, which is 
automatically installed with the OASYS PCI software, contains a complete website 
devoted to troubleshooting, setup and compatibility with third-party software and 
hardware, and usage tips. 

The FAQ is in HTML format, so that it can be read by any standard web browser, 
such as Netscape Navigator or Internet Explorer. To search through the FAQ, start 
by opening the document named “OASYS PCI_faq_index.htm.”

In addition to the FAQ installed with the OASYS PCI software, the latest version 
can always be found on the OASYS PCI website, at 
http://www.korg.com/oasyspci.htm.
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Hardware Installation
Installing the OASYS PCI is simple and straightforward. However, to make sure 
that you don’t damage the card or the computer, please read the instructions on 
pages 8-13 completely before performing the installation. They’re short, they’re 
sweet, and they’re even sprinkled with a few zippy graphics–the perfect 
accompaniment to a brief coffee break.

Unpacking
The OASYS PCI packages contain the following items:

• OASYS PCI audio card (don’t remove this from its envelope yet!)
• OASYS PCI software CD-ROM
• Analog breakout cable
• Digital breakout cable
• This manual
• Warranty card

The package may also contain a bundled software application.

System Requirements

MacOS

To use the OASYS PCI on a MacOS computer, you will need:

• A Macintosh computer with a PowerPC processor. For use as a standalone 
application, Korg recommends a minimum of a 200MHz 604e processor. For 
use in conjunction with digital audio software, Korg recommends a 
minimum of a 233MHz G3.

• MacOS version 8.5.1 or later.
• CD-ROM drive for installing software.
• A color monitor, with minimum resolution of 1024 x 768.
Third-party digital audio software may have additional requirements; please 
consult your manuals for details.

Windows 95/98

To use the OASYS PCI on a Windows 95/98 computer, you will need:

• A Windows 95/98-compatible computer. For use as a standalone application, 
Korg recommends a minimum of a 200MHz Pentium II processor. For use in 
conjunction with digital audio software, Korg recommends a minimum of a 
300MHz Pentium II processor.

• Microsoft Windows 95 or Windows 98.
• CD-ROM drive for installing software.
• A color monitor, with minimum resolution of 1024 x 768.
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Third-party digital audio software may have additional requirements; please 
consult your manuals for details.

Handle carefully!

Avoid static electricity
The OASYS PCI card is packaged within a protective anti-static envelope, which 
prevents static electricity from damaging its delicate electronic components. It’s a 
good idea to keep this envelope around; whenever you need to ship your card, or 
to store it outside of your computer, put it back in its envelope.

Before handling the card, always discharge any static electricity from your clothes 
and body by touching a grounded metal surface, such as the case around your 
computer’s power supply. After doing this, use one hand to hold the card by the 
metal jack panel (where the connectors are), and touch the power supply again 
with your other hand. 

While working with the card, avoid moving around on carpeted surfaces; shuffling 
your feet on a rug is almost guaranteed to build up a static charge. If you need to 
walk around in the middle of working with the card, just repeat the static discharge 
procedure before touching the card again.

These simple steps will ensure that a tiny little jolt of static electricity–like the kind 
that holds your socks together when they come out of the dryer–doesn’t zap your 
card into oblivion.

Hold the OASYS PCI by its edges
Did we already mention that the OASYS PCI uses a whole bunch of delicate 
electronic components? Well, OK, so we’ve said it again. To avoid damaging those 
lovely little silicon jewels, always hold the OASYS PCI by the edges of the card, or 
by the metal jack panel (where the connectors are). Don’t touch the electronic parts, 
the PCI connector pins, or any of the traces on the board (those little silvery paths 
that run between the components).

There, we’re done nagging now.

Installing the OASYS PCI card in your computer
The instructions below are a brief overview of the installation procedure; please 
consult your computer’s manuals for more detailed instructions. 

1. Shut down the computer.

2. Detach the power cable from the computer.

3. Remove the computer’s main cover.

4. Choose any available PCI slot. 

When installing into Apple-branded MacOS computers, you can use any available 
PCI slot. Don’t worry about which ones are “bus master” slots; on Apple 
computers, all PCI slots are capable of bus mastering. If you are installing the 
OASYS PCI 9
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OASYS PCI into a MacOS clone computer (from a manufacturer other than Apple), 
see the HTML FAQ for details on which PCI slots are appropriate. 

When installing into a Windows-compatible PC, consult your computer’s manual 
for details. OASYS PCI requires a bus master slot; on most modern PC 
motherboards, all slots are capable of bus mastering.

For each slot, there is a small port on the back of the computer, which allows access 
to one end of the card. For the OASYS PCI, the port allows access to the jack panel, 
into which you plug all your digital and analog connectors. There will be a small 
cover over the port.

5. Remove the cover from the port on the back of the computer. 

You may need to use a screwdriver, if your computer uses screws to secure the PCI 
cards and port covers. If you remove a screw, save it–we’ll use it again later on.

6. Before handling the OASYS PCI card, touch a grounded metal surface 
(such as your computer’s power supply). Follow the complete instructions 
under “Handle carefully!,” on page 9.

7. Before plugging the card in, align it with the selected PCI slot.

The jack panel should line up with the port on the back of the computer. There also 
should be a corresponding guide towards the front of the computer, to hold the 
other end of the card in place.

8. Press the card gently but firmly into the slot, until the connector is fully 
inserted.

Don’t force the card into the slot. If you encounter a lot of resistance, pull the card 
out and try inserting it again.

9. To make sure that the connector is properly inserted, pull on the card 
gently.

If the card resists your gentle pull and stays in place, then it’s inserted properly.

If it moves easily, then go back to step 8 and try again.

10. If you removed a screw in step 5, use it to secure the card to the case.

11. After installing the card in the slot, replace the computer’s main cover and 
power cable.

With the card installed in the computer, you’re now ready to connect it to your 
audio system.
10 OASYS PCI
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Audio Connectors
Korg engineers worked valiantly to squeeze an incredible number of inputs and 
outputs onto the OASYS PCI’s relatively small jack panel. To produce such a 
densely packed piece of digital audio real estate, they used two breakout cables–
that is, cables with a single connector on one end, fanning out to several connectors 
on the other. 

One of the breakout cables is dedicated to analog audio input and output, and the 
other is dedicated to digital signals, including S/PDIF audio, ADAT timecode, and 
BNC word clock I/O.

The OASYS PCI jack panel

❶ Analog breakout connector
This connector should only be used with the special Analog Audio breakout cable 
included with the OASYS PCI. This cable provides two analog inputs and two 
analog outputs, on standard 1/4” jacks.

Analog inputs left and right
These connectors are used to bring analog signals into the OASYS PCI. You can 
connect this to the output of a mixer, microphone pre-amp, synthesizer, and so on. 
The analog inputs use standard 1/4”, unbalanced connectors, referenced to a 
+4dBu signal level. The OASYS PCI uses 24-bit A/D converters, ensuring the 
highest possible audio quality.

Analog Audio Breakout Connector

ADAT Optical Input

ADAT Optical Output

Digital Audio Breakout Connector

❶

❷

❸

❹
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Microphones and electric guitar outputs should be sent through a mixer or pre-
amp first, to bring them up to +4 levels; otherwise, their signals will be weak.

Analog outputs left and right
These connectors are used to bring analog signals out of the OASYS PCI, into your 
mixer, amplifier, etc. 

As with the analog inputs, described above, the analog outputs use standard 1/4”, 
unbalanced connectors, referenced to a +4dBu signal level. The OASYS PCI uses 
24-bit D/A converters, ensuring the highest possible audio quality.

❷ ADAT optical input
The ADAT optical input carries eight channels of digital audio. You can connect 
this to the digital output of any multitrack recorder, digital mixer, effects processor, 
or other digital audio device which supports the ADAT optical format. 

You can also connect this to an ADAT optical A/D converter, which will provide 
the OASYS PCI with eight additional analog inputs.

The OASYS PCI provides full 24-bit ADAT optical functionality. 

❸ ADAT optical output
The ADAT optical output carries eight channels of digital audio. You can connect 
this to the digital input of any multitrack recorder, digital mixer, effects processor, 
or other digital audio device which supports the ADAT optical format.

You can also connect this to an ADAT optical D/A converter, which will provide 
the OASYS PCI with eight additional analog outputs.

The OASYS PCI provides full 24-bit ADAT optical functionality.

❹ Digital breakout connector
This connector should only be used with the special Digital breakout cable 
included with the OASYS PCI. This cable has a multi-pin connector at one end, 
which connects to the OASYS PCI, and fans out to a pair of RCA S/PDIF jacks, a 
pair of BNC Word Clock connectors, and a pair of ADAT 9-pin sync connectors. 

S/PDIF input. The white RCA connector, labeled “In,” is the S/PDIF input. You 
can connect this to the S/PDIF output of a DAT, signal processor, sampler, and so 
on. Please use high-quality, shielded, 75-ohm cables manufactured specifically for 
video or digital audio.

The OASYS PCI provides full 24-bit S/PDIF functionality.

S/PDIF output. The yellow RCA connector, labeled “Out,” is the S/PDIF output. 
You can connect this to the S/PDIF input of a DAT, signal processor, sampler, and 
so on. Please use high-quality, shielded, 75-ohm cables manufactured specifically 
for video or digital audio.

The OASYS PCI provides full 24-bit S/PDIF functionality.
12 OASYS PCI
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Word Clock input. The white BNC connector, labeled “In,” is the Word Clock 
input. This allows the sample rate of the OASYS PCI to be controlled by an external 
device. Connect this to the word clock output of the master clock source.

The Word Clock input requires a shielded, video-quality cable (75-ohm or greater 
impedance) with BNC connectors. This type of cable is different from those 
commonly used in analog audio applications, but is readily available at 
professional audio and video dealers.

Word Clock output. The yellow BNC connector, labeled “Out,” is the Word Clock 
output. This allows the OASYS PCI to control the sample rate of an external device; 
it will always echo the currently selected Clock Source. Connect this to the word 
clock input of the slave device.

As with the Word Clock input, above, the Word Clock output requires a shielded, 
video-quality cable, with 75-ohm or greater impedance.

ADAT sync input. This 9-pin connector receives timecode from an ADAT system. 
OASYS PCI-compatible digital audio software can use this to synchronize 
recording and playback with a connected ADAT system. Connect this to the 
ADAT’s sync out port. 

ADAT sync output. This 9-pin connector passes through timecode and MMC 
commands received at the ADAT sync input. You can use this to connect to other 
ADAT sync-compatible devices. 
OASYS PCI 13
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Software Installation
Installing the OASYS PCI software for MacOS

The OASYS PCI includes several important pieces of software for MacOS-
compatible computers, including low-level drivers, ASIO drivers, Sound Manager 
drivers, OMS and FreeMIDI drivers, editing software, synthesizer sounds, and 
effects. All of these are included on the CD-ROM shipped with the OASYS PCI.

To install the OASYS PCI software for MacOS:

1. Open the Extension Manager control panel.

2. If you’ve already created an Extension Set for use with digital audio 
programs, select it and skip to step 3. If not:

2a. Select the MacOS Base Set.

2b. Press the Duplicate Set button in the bottom right-hand corner of the 
window.

2c. Give the set a descriptive name, such as “audio” or “OASYS PCI.”

3. Turn off virtual memory, in the Memory control panel.

We recommend that virtual memory be disabled, especially when using the 
OASYS PCI with digital audio software.

4. Turn off AppleTalk, in the AppleTalk control panel.

5. Turn off File Sharing, in the Control Strip or in the File Sharing control 
panel.

AppleTalk and File Sharing can adversely affect the performance of the CPU.

6. Insert the Korg OASYS PCI CD-ROM into your computer’s CD-ROM 
drive.

The disk’s icon and window will appear on the desktop. 

7. Double click on the CD-ROM’s “OASYS PCI Read Me” file. 

This is a text file which contains any late-breaking information about the card and 
the software, including any additional installation instructions. 

8. Read the file.

After reading the file and following any instructions that it might contain…

9. Double-click on the “OASYS PCI Installer” icon.

The OASYS PCI Installer will open. 

10. Follow the instructions to install the OASYS PCI software on your hard 
disk. 

In general, it’s best to use the “Easy Install” option.

11. Restart the computer before using the OASYS PCI.
14 OASYS PCI
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You must restart in order to use the OASYS PCI software.

12. After successfully re-starting with the OASYS PCI extensions loaded, reset 
the Extension Manager as desired.

13. If you will be using the OASYS PCI with a simple serial port MIDI 
interface, without either OMS or FreeMIDI, see “Serial Port MIDI Setup 
(MacOS),” on page 17.

14. If you will be using the OASYS PCI with OMS-compatible software, see 
“Configuring OMS (MacOS),” on page 20.

15. If you will be using the OASYS PCI with FreeMIDI-compatible software, 
see “Configuring FreeMIDI (MacOS),” on page 23.

16. If you will be using the OASYS PCI with ASIO-compatible software, see 
“Configuring ASIO Software,” on page 26.

Installing the OASYS PCI software for Windows 95/98
The OASYS PCI includes several important pieces of software for Windows 95/98 
computers, including low-level drivers, MME drivers, ASIO drivers, MIDI drivers, 
the Wave Device Settings program, editing software, synthesizer sounds, and 
effects. All of these are included on the CD-ROM shipped with the OASYS PCI.

The instructions below assume that you have already optimized Windows for use 
with audio and MIDI programs. If you have not already done so, please see the 
OASYS PCI FAQ, along with the documentation for your audio and MIDI 
programs.

Installing the OASYS PCI drivers
To install the OASYS PCI drivers:

1. If you have not done so already, install the OASYS PCI card (see “Installing 
the OASYS PCI card in your computer” on page 9, above).

2. Turn the computer on.

Windows will automatically detect that a new card has been installed, and the 
Update Device Driver Wizard will appear.

3. Insert the Korg OASYS PCI CD-ROM into your computer’s CD-ROM drive.

4. Follow the on-screen instructions to finish the installation of the OASYS 
PCI drivers. 

5. When asked to do so, specify that you have the disk provided by the 
manufacturer.

6. When asked to do so, specify the path to the CD-ROM (since the Korg CD-
ROM contains the driver installation file, “oasyspci.inf,” along with the 
driver files themselves).

When the driver installation is complete, Windows will return you to the desktop. 
OASYS PCI 15
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Installing the OASYS PCI software
Next, you need to run the Korg OASYS PCI Software Setup, which will install the 
OASYS PCI software and add it to the Start menu.

1. Insert the Korg OASYS PCI CD-ROM into your computer’s CD-ROM 
drive.

The OASYS PCI CD-ROM disk supports Windows Auto-Play mode, so the 
software installation application should start automatically. If it does not start 
automatically, run the program named “setup.exe” on the CD-ROM.

2. Follow the on-screen instructions to finish the installation of the OASYS 
PCI software.

The on-screen instructions will walk you through the rest of the installation. 
16 OASYS PCI
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Serial Port MIDI Setup (MacOS)
You can use the OASYS PCI as a stand-alone synthesizer or effects processor with a 
simple serial-port MIDI interface, without OMS or FreeMIDI. To do this:

1. Open the OASYS PCI Editor program.

2. In the Edit menu, select “Preferences.”

The Preferences window will appear.

3. Click on the MIDI/Global tab.

The MIDI/Global preferences page will appear.

4. Set the MIDI System parameter to Serial Port.

The OASYS PCI will now use the standard serial port drivers for MIDI. Notice that 
the Serial Port parameters, named Serial Port and Interface Speed, are no longer 
grayed out.

5. Set the Serial Port parameter to the port that you’d like to use.

The OASYS PCI can use either the Modem or Printer ports for MIDI.

6. Set the Interface Speed to match the speed of the hardware MIDI interface.

Almost all MIDI interfaces use “1x,” which is the default.

The OASYS PCI will now receive MIDI from the selected serial port.

NOTE: When the MIDI System is set to Serial Port, only 16 channels of MIDI (A1-
A16) are available. Channels B1-B16 will not carry any data.

USB MIDI Interfaces (MacOS)
The direct serial port drivers only support “classic” MacOS serial ports. For use 
with a USB MIDI Interface, use OMS or FreeMIDI instead.
OASYS PCI 17
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MIDI Setup (Windows)
OASYS PCI automatically appears to the Windows multimedia system as two 16-
channel MIDI devices. You can select these MIDI devices within any MIDI 
program.

Using the OASYS PCI with Windows MIDI programs
When using the OASYS PCI with an OMS sequencer, we recommend that you 
enable MIDI patch-through in the sequencer, and disable direct MIDI input to the 
OASYS PCI. To do this:

1. Open the OASYS PCI Editor program.

2. In the Edit menu, select “Preferences.”

The Preferences window will appear.

3. Click on the MIDI/Global tab.

The MIDI/Global preferences page will appear.

4. Turn off the “Editor Responds to MIDI Controllers” checkbox.

This is similar to the Local On/Off parameter found on some synthesizers. 
Turning it off means that the OASYS PCI will not directly receive MIDI from MIDI 
controllers. Instead, it will only respond to MIDI patched through from other 
programs, such as a MIDI sequencer.

This setting prevents various strange things from happening, including phasing, 
hung notes, and notes cutting off prematurely.

5. In the MIDI program, enable MIDI patch through.

This will patch the MIDI output of your controller through to the OASYS PCI. The 
name of the parameter may vary depending on the particular MIDI program being 
used. Depending on the program, you also may need to select a track assigned to 
the OASYS PCI, and/or record enable the track. Please consult the program’s 
manual for details.

6. Read the OASYS PCI FAQ for more information on specific MIDI 
programs.

The HTML-format OASYS PCI FAQ has detailed, step-by-step instructions for 
setting up OASYS PCI with specific MIDI programs, such as Cubase, Logic, and 
Cakewalk.

Using the OASYS PCI Editor as a stand-alone MIDI program
When using the OASYS PCI Editor as a stand-alone synthesizer or effects 
processor, without any other MIDI program, you will need to enable direct MIDI 
input to the OASYS PCI. To do this:

1. Open the OASYS PCI Editor program.
18 OASYS PCI
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2. In the Edit menu, select “Preferences.”

The Preferences window will appear.

3. Click on the MIDI/Global tab.

The MIDI/Global preferences page will appear.

4. Turn on the “Editor Responds to MIDI Controllers” checkbox.

This is similar to the Local On/Off parameter found on some synthesizers. Turning 
it on means that the OASYS PCI will directly receive MIDI from MIDI controllers.
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Configuring OMS (MacOS)
OMS allows the OASYS PCI’s MIDI functions to be accessed directly from OMS-
compatible MacOS software, including Cakewalk Metro, Cubase VST, Logic 
Audio, Vision DSP, and Studio Vision Pro.

The instructions below assume that you have already installed OMS on your 
computer.

Installing the OASYS PCI OMS Driver
OMS needs the OASYS PCI OMS Driver to communicate with the OASYS PCI. 
The installer will place a copy of the OASYS PCI OMS Driver in the OMS folder, 
within the System folder. 

If this driver is removed from the OMS folder, OMS programs will not be able to 
see the OASYS PCI. In this case, use the OASYS PCI installer program to re-install 
the OASYS PCI OMS Driver.

Selecting OMS as the OASYS PCI MIDI system
To use the OASYS PCI with OMS software, you need to set the OASYS PCI to use 
OMS as its MIDI system. To do this:

1. Open the OASYS PCI Editor program.

2. In the Edit menu, select “Preferences.”

The Preferences window will appear.

3. Click on the MIDI/Global tab.

The MIDI/Global preferences page will appear.

4. Set the MIDI System parameter to OMS.

The OASYS PCI will now use OMS as its MIDI system.

Adding the OASYS PCI to the OMS Studio Setup
Once the OASYS PCI OMS Driver is installed, OMS needs to be configured to add 
the OASYS PCI to the Studio Setup. To do this:

1. Open the OMS Setup application.

The current OMS Studio Setup document will be opened.

2. In the Studio menu, select MIDI Cards & Interfaces.

A dialog box will appear.

3. Click the Update Setup button.

The OMS Driver Search window will appear.

4. De-select all of the serial ports.
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It isn’t necessary to search the serial ports in this case, and de-selecting them will 
make the search faster.

5. Click the Search button.

OMS will automatically detect the OASYS PCI, and add two devices to the Studio 
Setup, named OASYS PCI A and OASYS PCI B. The OASYS PCI devices are not 
connected to any serial ports or MIDI interfaces, since they connect directly to 
OMS.

6. In the Edit menu, select OMS MIDI Setup.

The OMS MIDI Setup dialog will appear.

7. Enable the “Run MIDI in Background” checkbox.

This allows OMS MIDI programs to continue to play while you work in the OASYS 
PCI Editor. If Run MIDI in Background is not enabled, switching from an OMS 
MIDI sequencer to the OASYS PCI Editor will cause the sequencer to stop playing. 
This will also prevent the MIDI Program from sending any MIDI data (including 
MIDI from your controller keyboard) to the OASYS PCI.

8. Save the edited OMS setup.

The OASYS PCI will now appear in your OMS programs as two devices, OASYS 
PCIA and OASYS PCIB, for a total of 32 MIDI channels.

Using the OASYS PCI with an OMS sequencer
When using the OASYS PCI with an OMS sequencer, we recommend enabling 
MIDI patch-through in the sequencer, and disabling direct MIDI input to the 
OASYS PCI. To do this:

1. Open the OASYS PCI Editor program.

2. In the Edit menu, select “Preferences.”

The Preferences window will appear.

3. Click on the MIDI/Global tab.

The MIDI/Global preferences page will appear.

4. Turn off the “Editor Responds to OMS/FreeMIDI Controllers” checkbox.

This is similar to the Local On/Off parameter found on some synthesizers. Turning 
it off means that the OASYS PCI will not directly receive MIDI from MIDI 
controllers. Instead, it will only respond to MIDI patched through from other OMS 
programs, such as an OMS sequencer.

This setting prevents various strange things from happening, including phasing, 
hung notes, and notes cutting off prematurely.

5. In the OMS sequencer, enable MIDI patch through.

This will patch the MIDI output of your controller through to the OASYS PCI. The 
name of the parameter may vary depending on the particular OMS program being 
used. Depending on the program, you also may need to select a track assigned to 
OASYS PCI 21



Configuring OMS (MacOS) Installation and Setup

E
ng

lis
h

the OASYS PCI, and/or record enable the track. Please consult the program’s 
manual for details.

6. Read the OASYS PCI FAQ for more information on specific MIDI 
programs.

The HTML-format OASYS PCI FAQ has detailed, step-by-step instructions for 
setting up OASYS PCI with specific OMS programs, such as Vision, Cubase, and 
Logic.

Using the OASYS PCI Editor as a stand-alone OMS program
When using the OASYS PCI Editor as a stand-alone synthesizer or effects 
processor, without any other OMS program, you will need to enable direct MIDI 
input to the OASYS PCI. To do this:

1. Open the OASYS PCI Editor program.

2. In the Edit menu, select “Preferences.”

The Preferences window will appear.

3. Click on the MIDI/Global tab.

The MIDI/Global preferences page will appear.

4. Turn on the “Editor Responds to OMS/FreeMIDI Controllers” checkbox.

This is similar to the Local On/Off parameter found on some synthesizers. 
Turning it on means that the OASYS PCI will directly receive MIDI from MIDI 
controllers.
22 OASYS PCI



Installation and Setup Configuring FreeMIDI (MacOS)

E
nglish
Configuring FreeMIDI (MacOS)
FreeMIDI allows the OASYS PCI’s MIDI functions to be accessed directly from 
FreeMIDI-compatible MacOS software, including Performer and Digital Performer.

The instructions below assume that you have already installed FreeMIDI on your 
computer.

Installing the OASYS PCI FreeMIDI Driver
FreeMIDI needs the OASYS PCI FreeMIDI Driver to communicate with the OASYS 
PCI. The installer will place a copy of the OASYS PCI FreeMIDI Driver in the 
FreeMIDI folder, within the System folder. 

If this driver is removed from the FreeMIDI folder, FreeMIDI programs will not be 
able to see the OASYS PCI. In this case, use the OASYS PCI installer program to re-
install the OASYS PCI FreeMIDI Driver.

Selecting FreeMIDI as the OASYS PCI MIDI system
For use with FreeMIDI software, you need to set the OASYS PCI’s MIDI system to 
FreeMIDI. To do this:

1. Open the OASYS PCI Editor program.

2. In the Edit menu, select “Preferences.”

The Preferences window will appear.

3. Click on the MIDI/Global tab.

The MIDI/Global preferences page will appear.

4. Set the MIDI System parameter to FreeMIDI.

The OASYS PCI will now use FreeMIDI as its MIDI system.

Adding the OASYS PCI to the FreeMIDI setup
Once the OASYS PCI FreeMIDI Driver is installed, FreeMIDI needs to be 
configured to add the OASYS PCI to the FreeMIDI setup. To do this:

1. Open the FreeMIDI Setup application.

The current FreeMIDI Setup document will be opened.

2. In the File menu, select FreeMIDI Preferences.

The FreeMIDI Preferences dialog box will appear.

3. Under Software Compatibility, select FreeMIDI Applications Only.

This allows you to use the OASYS PCI Editor program while the FreeMIDI 
program plays in the background.

4. Under MIDI Configuration, enable Applications: Inter-application MIDI.
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This allows the OASYS PCI Editor’s knobs to respond to MIDI SysEx parameter 
changes. If Inter-application MIDI is disabled, parameter changes will still affect 
the sound, but the knobs will not move to reflect the changes.

5. Under MIDI Configuration, make sure that both OASYS PCI A and 
OASYS PCI B are checked.

This enables the OASYS PCI FreeMIDI driver. Two new devices, OASYS PCI A 
and OASYS PCI B, will appear in the FreeMIDI Setup document.

6. Save the edited FreeMIDI setup.

The OASYS PCI will now appear in your FreeMIDI programs as two devices, 
OASYS PCI A and OASYS PCI B, for a total of 32 MIDI channels.

Using the OASYS PCI with Performer and Digital Performer
When using the OASYS PCI with a FreeMIDI sequencer, such as Performer and 
Digital Performer, we recommend enabling MIDI patch-through in the sequencer, 
and disabling direct MIDI input to the OASYS PCI. To do this:

1. Open the OASYS PCI Editor program.

2. In the Edit menu, select “Preferences.”

The Preferences window will appear.

3. Click on the MIDI/Global tab.

The MIDI/Global preferences page will appear.

4. Turn off the “Editor Responds to OMS/FreeMIDI Controllers” checkbox.

This is similar to the Local On/Off parameter found on some synthesizers. 
Turning it off means that the OASYS PCI will not directly receive MIDI from MIDI 
controllers. Instead, it will only respond to MIDI patched through from other 
FreeMIDI programs, such as Performer or Digital Performer.

This setting prevents various strange things from happening, including phasing, 
hung notes, and notes cutting off prematurely.

5. In Performer or Digital Performer, select Patch Thru from the Basics menu.

The Patch Thru dialog box will appear.

6. Select the “Auto-channelize” option.

With this setting, Performer and Digital Performer will automatically patch MIDI 
through to record-enabled tracks.

7. Still in the Patch Thru dialog box, enable Patch Thru In Background.

This setting means that even when Performer or Digital Performer is in the 
background, it will still send the output of your MIDI controller to the OASYS PCI.

8. Read the OASYS PCI FAQ for more information on use with Digital 
Performer.
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The HTML-format OASYS PCI FAQ has detailed, step-by-step instructions for 
setting up OASYS PCI with Digital Performer.

Using the OASYS PCI Editor as a stand-alone FreeMIDI program
When using the OASYS PCI Editor as a stand-alone synthesizer or effects processor, 
without any other FreeMIDI program, you will need to enable direct MIDI input to 
the OASYS PCI. To do this:

1. Open the OASYS PCI Editor program.

2. In the Edit menu, select “Preferences.”

The Preferences window will appear.

3. Click on the MIDI/Global tab.

The MIDI/Global preferences page will appear.

4. Turn on the “Editor Responds to OMS/FreeMIDI Controllers” checkbox.

This is similar to the Local On/Off parameter found on some synthesizers. Turning 
it on means that the OASYS PCI will directly receive MIDI from MIDI controllers.
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Configuring ASIO Software
The OASYS PCI includes ASIO drivers, for direct compatibility with MacOS and 
Windows digital audio programs such as Cakewalk Metro, Cool Edit Pro, Cubase 
VST, Deck, Digital Performer, Logic Audio, Peak, TC Spark, and more.

Installing the OASYS PCI ASIO driver

ASIO 1.0 vs. ASIO 2.0
ASIO drivers currently come in two flavors: ASIO 1.0 and ASIO 2.0. ASIO 1.0 is the 
initial version of the driver standard, and ASIO 2.0 adds new features such as 
support for sample-accurate timecode and control of hardware-based monitoring. 
OASYS PCI includes drivers for both ASIO 1.0 and ASIO 2.0.

Many programs work well with either version of ASIO, but some programs may 
only work with ASIO 1.0 drivers - and they may even crash when an ASIO 2.0 
driver is selected. 

If you are installing an ASIO driver for a particular program, find out what version 
of ASIO is appropriate for that program. If in doubt, use the OASYS PCI ASIO 1.0 
driver. 

The ASIO 1.0 driver may not be included on your OASYS PCI CD-ROM. If not, 
you can download it from the OASYS PCI website, at 
http://www.korg.com/oasyspci_software.htm.

MacOS
MacOS digital audio programs require that ASIO drivers be placed in a particular 
folder. Usually, this folder is named “ASIO Drivers,” and is located in the same 
folder as the program itself. Please consult your program’s manual for more 
details.

The installer will place an OASYS PCI ASIO 2.0 driver into each folder named 
“ASIO Drivers.” If an ASIO-compatible program does not recognize the OASYS 
PCI, make sure that the correct version of the OASYS PCI ASIO driver is in the 
appropriate folder. 

If the driver isn’t there, install it using the Custom Install option of the OASYS PCI 
Installer, on the OASYS PCI CD-ROM. Or, if you have a copy of the ASIO driver on 
your hard disk already, you can add it manually simply by dragging a copy of the 
driver into the folder.

You will also need to manually add an OASYS PCI ASIO driver if you install new 
ASIO-compatible software after installing the OASYS PCI software.
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Windows
The OASYS PCI Windows installer will register OASYS PCI as an ASIO device via 
REGSVR32.INI. This will allow ASIO-compatible programs, such as Cubase VST 
and Cool Edit Pro, to recognize OASYS PCI via ASIO.

Selecting the OASYS PCI as the ASIO device
After the OASYS PCI ASIO Driver is installed in the correct folder, you need to tell 
the digital audio program to use the OASYS PCI as the ASIO Device. Different 
programs will do this in different ways; consult the program’s manual for details.

Read the FAQ for more information on specific ASIO programs
The HTML-format OASYS PCI FAQ has detailed, step-by-step instructions for 
setting up OASYS PCI with a number of ASIO programs, such as Cubase VST, 
Logic Audio, Digital Performer, and Vision.

Setting the sample rate and word clock source
Whenever an ASIO-compatible audio program is running, be sure to set the sample 
rate and word clock source from within the audio program, as opposed to using the 
OASYS PCI Editor preferences settings. Otherwise, the audio program may not 
know that the sample rate or clock source has changed.

The OASYS PCI Editor’s settings will reflect the clock and sample rate settings 
made within the digital audio program.

For more information on setting the sample rate and word clock source, please see 
“A few words on word clock” on page 38. Also see the Users Guide, under “ASIO 
Control Panel/Audio Settings” and “Using Audio Programs.”

More information on using ASIO
For more information on ASIO and the OASYS PCI, please see the Users Guide, 
under “ASIO Control Panel/Audio Settings” and “Using Audio Programs.”
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Configuring Sound Manager 
(MacOS)
The Apple Sound Manager controls the basic sound input and output for the 
computer as a whole, including system alert beeps, speech input and output, game 
sounds, and so on. The Sound Manager also allows add-on hardware, such as the 
OASYS PCI, to be used in place of the computer’s built-in sound input and output.

When you are using the OASYS PCI through the Sound Manager, only two 
channels are available for input and output; you can choose any stereo pair that 
you like (analog, S/PDIF, or ADAT 1-2, 3-4, 5-6, and 7-8). You can even use one 
pair of channels for input, and another for output. 

Sound Manager setup
Apple’s Sound control panel is included in the OASYS PCI software installation. It 
is also included in the “Apple Extras” folder This control panel is not 
automatically installed with the MacOS system software, but it works much better 
with third-party audio hardware than do the other sound-oriented control panels 
(including Monitors & Sound). 

For this reason, only the Sound control panel is recommended for configuring the 
OASYS PCI and Sound Manager.

You can continue to use the Monitors & Sound control panel for any purpose other 
than configuring the OASYS PCI for use with Sound Manager. 

To set up the Sound Manager to use the OASYS PCI:

1. Open the Sound control panel.

2. Select “Sound In” from the Sound control panel’s menu.

The Sound In page appears, with the on-screen instruction, “Choose a source for 
recording.”

3. Select the OASYS PCI icon.

It will become hilighted. The OASYS PCI will now be used for input to Sound 
Manager-compatible programs.

4. Select “Sound Out” from the menu.

The Sound Out page appears, with the on-screen instruction, “Choose a device for 
playback.”

5. Select the OASYS PCI icon.

It will become hilighted. The OASYS PCI will now be used for output from Sound 
Manager-compatible programs.

The Sound control panel also includes an output volume setting.
28 OASYS PCI



Installation and Setup Configuring Sound Manager (MacOS)

E
nglish
6. Select “Volumes” from the menu.

7. Set the OASYS PCI’s output volume to the maximum value. 

With the OASYS PCI selected in the Sound control panel, the computer will now 
use the OASYS PCI for all sound input and output, including alert sounds (the alert 
sound is the “beep,” or other sound, which plays when software displays a 
warning message). To keep extraneous MacOS beeps and chirps out of your digital 
audio system, you may wish to turn the alert volume off entirely.

8. Optional: select “Alert Sounds” from the menu, and turn the Alert Sound 
volume all the way down.

The Sound Manager supports only two inputs and two outputs. Using the OASYS 
PCI Sound Manager control panel, you can set the inputs and outputs to use any 
two of the OASYS PCI’s channels.

9. Select “Sound In” again, from the Sound control panel’s menu.

10. Press the Options button.

The OASYS PCI Sound Manager control panel will appear.

Sound Manager Control Panel

11. Select the desired OASYS PCI channels in the Input Selection and Output 
Selection menus.

You can also change these as necessary, whenever you like.
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12. Set the Clock Source/Sample Rate and Analog Input and Output Trims as 
desired.

For more information on these parameters, please see “Word clock and sample 
rate settings” on page 33.

That’s it! You’re now ready to use the OASYS PCI with Sound Manager programs.
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Configuring MME (Windows)
The OASYS PCI is designed for seamless use with all MME-compatible digital 
audio programs, such as Cakewalk Pro Audio, Logic Audio, Cubase VST, SAW, 
Cool Edit Pro, Sound Forge, Acid, etc. 

OASYS PCI also supports ASIO, for use with ASIO-compatible programs including 
Cubase VST and Cool Edit Pro. For more information on setting up ASIO, please 
see “Configuring ASIO Software,” on page 26.

Using the OASYS PCI as multiple wave devices
Through the OASYS PCI’s standard wave device driver, you can use the card with 
any standard Windows digital audio program. The OASYS PCI appears as six full-
duplex stereo devices, one for each input/output pair, as well as four stereo output-
only devices, for the eight Streams. 

Programs which support the use of multiple audio devices have simultaneous 
access to all 12 inputs and 20 outputs, up to the limits of the program itself. 

The OASYS PCI Wave Device Settings program controls the card’s sample rate, 
word clock source, and play/record synchronization. Optionally, it also lets you set 
volume and balance for each output device. From this program, you can also call 
up the Audio Settings, Hardware Meters, and Diagnostics windows.

To set up the OASYS PCI for use with MME audio programs:

1. Open the OASYS PCI Wave Device Settings program.

2. Select the desired sample rate and word clock source.

3. Make sure that the Auto Sync button is on.

This will ensure that all of the input and output pairs are synchronized. In some 
special cases, you may wish to disable Auto Sync; for more information, see the 
section “Wave Device Settings (Windows)” in the Users Guide.

4. Press the Audio Settings button.

The OASYS PCI Audio Settings window will appear.

5. Set up input-to-output monitoring as desired, using the channel routing and 
volume controls.

For more information, see the section “ASIO Control Panel/Audio Settings” in the 
Users Guide.

6. Optional: to use the OASYS PCI as the default input and/or output wave 
device, use the Multimedia Properties control panel. 

For more information, see “Setting the default playback or recording device,” on 
page 32.
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Wave device numbering
When selecting OASYS PCI inputs and outputs in digital audio software, each 
stereo pair is identified by name, PCI bus, and PCI device number - such as ADAT 
3-4, Bus 0, Device 11. 

However, the Windows multimedia system keeps track of each audio device 
simply by a number, generated by the order in which they were initialized. It is 
this number that is stored in a digital audio program’s input and output 
assignments.

You can check the device order by looking at the audio “preferred device” menus 
in the Multimedia Properties control panel. In these menus, the devices are shown 
in order (although no actual numbers are displayed).

If you install or remove other soundcards, this may change the device numbers 
assigned to the OASYS PCI. This, in turn, can change the track output assignments 
of previously recorded files. If so, you’ll need to re-select the desired outputs, and 
save the updated file.

As mentioned previously, the OASYS PCI appears to the Windows multimedia 
system as ten stereo audio devices–one for each stereo pair. The devices appear in 
the following order: Analog L/R, S/PDIF L/R, ADAT 1-8, and Stream 1-8.

Setting the default playback or recording device
Some programs will automatically use only the default recording and playback 
devices, as set in the Multimedia Properties control panel. To select the OASYS PCI 
as the default device:

1. Open the Multimedia Properties control panel.

2. Select the desired OASYS PCI channels as the preferred device under both 
Playback and Recording. 

3. Set the Preferred Quality to CD Quality.

This will set the audio device to stereo, 16 bit, 44.1kHz sample rate. You can use 
the Customize button to select other sample rates and bit depths, if desired; the 
44.1, 22.05, and 11.025kHz sample rates are valid for the OASYS PCI.

Note also that the volume controls in the Multimedia Properties control panel are 
disabled when the OASYS PCI is selected. The OASYS PCI’s output volumes may 
be adjusted using the OASYS PCI Wave Device Settings program, if desired.
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System Configurations
This chapter is intended to provide a quick guide for integrating the OASYS PCI 
into a variety of different setups. By its nature, the instructions here are brief; for 
additional detail, please consult the manuals of the other digital audio hardware 
and software being used. 

Be sure to consult the OASYS PCI FAQ for information on specific audio/MIDI 
programs, as well as any late-breaking information.

Word clock and sample rate settings
With digital audio cards, the great majority of technical support questions are the 
result of incorrect word clock settings. Incorrect word clock settings may cause 
subtle degradation of audio, louder pops and clicks, altered pitch and playback 
speeds, and/or timecode problems. 

Keeping track of the word clock source may seem confusing at first, but it’s really 
pretty simple. Just remember that, as with SMPTE synchronization setups, there 
must be one and only one word clock master, with all other devices set to slave to 
the master device. This means that you need to keep track of the word clock 
settings on all of your digital audio devices–not just on the OASYS PCI.

For more background information, see “A few words on word clock,” on page 38.

Sample rate setting must match external clock source
When you record or play back audio data using external clock sources (such as the 
S/PDIF, ADAT, or Word Clock inputs), the sample rate is controlled entirely by the 
external source, and not by the digital audio program’s sample rate parameter. 
Because of this, you must make sure that the external clock source is actually set to 
the same sample rate as the digital audio program. If the two are different, it can 
result in audio playing back faster or slower than expected.

Setting the word clock source in the OASYS PCI Editor
You can set the OASYS PCI’s sample rate and word clock source from within the 
OASYS PCI Editor. To do so:

1. In the OASYS PCI Editor, select Preferences… from the Edit menu.

The Preferences window will appear.

2. Click on the MIDI/Global tab.

The MIDI/Global page will appear.

The Sample Rate and Clock Source parameters are in the Global Settings section, in 
the lower right-hand corner of the window.

3. Set the Sample Rate and Clock Source as desired.
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NOTE: This is only recommended when using the OASYS PCI as a stand-alone 
synthesizer and/or effects processor. When using OASYS PCI in conjunction with 
digital audio software, we recommend setting these parameters from within the 
audio software instead, as described below.

Setting the word clock source in digital audio software
When using the OASYS PCI with ASIO-compatible digital audio programs (or 
other programs which directly support the OASYS PCI), you should set the 
sample rate and clock source within the audio program. This will ensure that the 
audio program and the OASYS PCI agree on the current settings. 

The OASYS PCI Editor’s settings will reflect the clock and sample rate settings 
made within the digital audio program.

For information on setting the clock source within a specific digital audio 
program, please refer to the program’s manual.

Using only the OASYS PCI’s analog input and output
You can use the OASYS PCI via only the analog inputs and outputs, if you like, 
without any digital connections. In this case, you should generally set the OASYS 
PCI’s word clock source to Internal.

Using the OASYS PCI with ADAT-compatible digital mixers
You can connect the OASYS PCI to an ADAT-compatible digital mixer in various 
ways, depending on your other equipment and your personal preference. 

Mixer as word clock master
The simplest way is to use the mixer as the word clock master. In this case:

1. Connect the OASYS PCI’s ADAT optical input and output to the mixer.

2. Make sure that the mixer is set to use its internal clock.

3. Set the OASYS PCI’s word clock source to ADAT.

OASYS PCI as word clock master
In some cases, you may wish to use the OASYS PCI as the master clock. In this 
case:

1. Connect the OASYS PCI’s ADAT optical input and output to the mixer.

2. Set the OASYS PCI’s word clock source to Internal.

3. Set the mixer to use the OASYS PCI’s ADAT output as the master clock.

External word clock generator as master
You may also wish to use a stand-alone word clock generator or SMPTE-to-digital 
audio converter as the master. In this case:
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1. Connect the word clock generator’s output to the word clock input of both 
the mixer and the OASYS PCI.

2. Set the word clock source of both devices to Word Clock.

Using the OASYS PCI with ADAT-compatible A/D and D/A converters
You can connect the OASYS PCI to ADAT-compatible A/D and D/A converters in 
various ways, depending on your other equipment and your personal preference. 

OASYS PCI as word clock master
With a combined A/D and D/A converter, it will generally be easiest to use the 
OASYS PCI as the word clock master. In this case:

1. Connect both the OASYS PCI’s ADAT input and output to the converter.

2. Set the OASYS PCI’s word clock source to Internal.

3. Set the converter to use the ADAT input as the clock source.

Converter as word clock master
You may also use the converter as the clock source. In this case:

1. Connect both the OASYS PCI’s ADAT input and output to the converter.

2. Set the converter to use its internal clock.

3. Set the OASYS PCI’s word clock source to ADAT.

External word clock generator as master
You may also wish to use a stand-alone word clock generator or SMPTE-to-digital 
audio converter as the master. In this case:

1. Connect the word clock generator’s output to the word clock input of both 
the converter and the OASYS PCI.

2. Set the word clock source of both devices to Word Clock.

Using the OASYS PCI with ADAT-compatible tape machines
The OASYS PCI will work equally well in a system with only one ADAT-
compatible tape machine (from now on, we’ll just call that an “ADAT” for short), or 
in a more complex system with multiple ADATs and a remote controller, such as 
the Alesis BRC.

To connect the OASYS PCI to an ADAT system:

1. Connect the ADATs together as usual, with the sync and optical outputs 
from ADAT #1 going into ADAT #2, from ADAT #2 to ADAT #3, and so on.

2. Connect the sync output from the last ADAT to the OASYS PCI’s ADAT 
Timecode Input.

3. Connect the optical outputs from the last ADAT to the optical inputs of the 
OASYS PCI.
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4. Connect the optical output of the OASYS PCI to the optical input of ADAT 
#1.

5. If using an Alesis BRC, connect the BRC’s sync output to ADAT #1’s sync 
input, and then connect the Word Clock output of the OASYS PCI to the 
48kHz Input of the BRC.

This connection is necessary when recording from the OASYS PCI’s S/PDIF input.

6. For general use, set the OASYS PCI’s word clock source to ADAT, and the 
ADAT system’s word clock source to Internal.

For details on setting the word clock source for a particular ADAT model, see the 
ADAT’s manual, or the OASYS PCI FAQ.

Below is a nifty little diagram, showing the OASYS PCI hooked up in a simple 
system with two ADATs and a BRC. If you have more ADATs than shown here 
(lucky you!), just pretend that this diagram’s ADAT #2 is the last one in your 
chain.

The OASYS PCI with 2 ADATs and a BRC

SyncOptical

SyncOptical

SyncOptical

Word
Clock

Word Clock

BRC

ADAT #1

ADAT #2

OASYS PCI
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Using the OASYS PCI with S/PDIF devices (DAT, effects, etc.)
There are two broad classifications of S/PDIF devices: those which can use an 
external clock to control their digital output, and those which cannot. These two 
types require different settings on the OASYS PCI.

Devices which do not accept external word clock
Many S/PDIF devices don’t have a separate setting for the word clock source. For 
instance, many DAT machines automatically use incoming digital audio data as the 
word clock source when recording, and automatically use the internal clock source 
when playing back. Some stand-alone A/D converters also may not accept an 
external word clock input. 

When recording from such devices, all the other devices must slave to the S/PDIF 
device’s clock.

1. Connect the digital audio cables between the S/PDIF input and output of 
the OASYS PCI and the S/PDIF device.

2. When recording from the S/PDIF device into a digital audio program, set the 
OASYS PCI’s word clock source to S/PDIF. 

3. When playing back into the S/PDIF device from a digital audio program, set 
the OASYS PCI’s word clock source to Internal (or ADAT, if you generally 
use an ADAT system as the master clock source).

Devices which accept external word clock
Some S/PDIF devices, on the other hand, may allow you to freely select between 
internal and external word clock. Some may use a dedicated word clock input; 
others may use the clock signal received at their S/PDIF input.

When using the OASYS PCI with these devices, you don’t need to change word 
clock settings between recording and playback. Instead:

1. Connect the digital audio cables between the S/PDIF input and output of 
the OASYS PCI and the S/PDIF device.

2. If the S/PDIF device has a dedicated word clock input, connect the word 
clock output of the OASYS PCI to the word clock input of the S/PDIF 
device.

3. Set the S/PDIF device to use the external clock source.

4. In the digital audio program, set the OASYS PCI’s word clock source to 
Internal or ADAT, as desired.

You can also use a dedicated word clock source as the master for the OASYS PCI. In 
this case, connect the word clock output of the master device to the word clock 
input of the OASYS PCI, and set the OASYS PCI’s word clock source to Word 
Clock.
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A few words on word clock
Whenever two or more audio devices are connected together digitally, they are 
sending and receiving thousands of individual bits of data every second.The bits 
are sent out continuously, one after another, at a very steady pace. This is similar to 
two jugglers passing balls between each other, while at the same time keeping up 
their own steady juggling patterns.

When one device sends out a bit of data (like the ball being thrown to the other 
juggler), the other needs to be ready to receive it. If the data is being sent even just 
slightly faster than it can be received, bits will be lost, causing errors in the audio 
(like the ball being dropped). 

Similarly, if the data is being sent even slightly slower than the receiver expects it 
to be, then the receiver will occasionally be left without real data at its input (like a 
juggler grabbing at the air). In digital audio, these errors show up as loud pops 
and clicks, as well as lower-level noise.

The rate at which those bits are sent and received is controlled by the word clock, 
which “ticks” for every bit of data. Each device has its own word clock, so that it 
can work on its own–such as a single ADAT, or a single OASYS PCI. 

When you send digital audio data between two or more devices, however, their 
word clocks need to be synchronized together, so that devices send and receive 
each bit at the exact same moment. One of the devices–usually the sender–will 
provide the master clock; the others must be set to ignore their internal clocks, and 
instead slave to the master clock. 

This clock signal is normally carried along with the digital audio data, so that 
when connecting two devices together in a simple configuration–such as 
connecting OASYS PCI to a digital mixer, or dubbing between two DAT 
machines–you don’t need to make any other connections. You will, however, need 
to make sure that only one device is providing the master clock, and that all the 
other devices are set so that they slave their clocks to the master (or to another 
slave device).

Sometimes, it may also necessary to send the word clock separately from the 
digital audio data. For instance, you may be using a dedicated word clock 
generator, or a SMPTE-digital audio synchronizer. In this case, as before, you need 
to make sure that all devices are set to slave to the master clock.

It is best to set up a studio to use a single clock, and to stay with that clock at all 
times (or as much as possible). This will help to ensure that all timing and pitch 
remains the same.
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Instant Gratification
Loading and playing Multis

Now that you’ve installed the OASYS PCI hardware and software, let’s play some 
sounds!

1. Make sure that the analog outputs of the OASYS PCI are connected to your 
mixer or sound system, and that your MIDI controller (keyboard, guitar, 
etc.) is connected to your computer, and is set to transmit on MIDI channel 
1.

The Korg preset Multis respond to MIDI channel 1, and play from the card’s 
analog outputs. 

If you are using OASYS PCI with Windows, skip to step 3. 

If you are using OASYS PCI with MacOS, follow step 2:

2. If you have set up the OASYS PCI to use OMS, follow the instructions 
under “Using the OASYS PCI Editor as a stand-alone OMS program” on 
page 22. After this, go on to step 3. 
or
If you have set up the OASYS PCI to use FreeMIDI, follow the instructions 
under “Using the OASYS PCI Editor as a stand-alone FreeMIDI program” 
on page 25. After this, go on to step 3.
or
If you have set up the OASYS PCI to use the standard serial MIDI 
interface, go on to step 3.

The installer program will have opened two folders on the desktop. One of these is 
named “OASYS PCI Demo Multis.” This folder contains a number of demo 
sounds, which show off different aspects of the OASYS PCI.

3. Open one of the demo Multis, by double-clicking its icon on the desktop. 

The OASYS PCI Editor will open, and the selected Multi will appear. Multis are 
complete setups for the OASYS PCI, including all of the settings for the onboard 
digital mixer, along with all settings for synthesizer sounds and effects.

4. Play on your MIDI controller.

Enjoy! 

When you’d like to hear another sound:

5. If you’ve opened any other windows, make sure that the main Mixer 
window is in the foreground.

6. Select Close from the File menu.

The window will close. Since you closed the main Mixer window, the Multi will 
close as well. If you’ve changed anything, a message will appear asking if you’d 
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like to save your changes; press the Don’t Save button (MacOS) or the No button 
(Windows).

7. In the desktop, double-click on the icon of another Multi. 
or
Select Open… from the File Menu, and select a new Multi.

As the shampoo bottles say, “repeat as desired.”

After you’re done listening to a few sounds, make sure to read at least the chapter 
“Using the OASYS PCI” in the Users Guide. There’s a lot to the OASYS PCI, and we 
wouldn’t want to you miss anything!

Specifically, for more information on loading sounds, see the “Using Multis” 
section in the Users Guide. For information on loading effects, see “Using Effects” 
in the Users Guide.
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What are...?
File Types

The OASYS PCI use a number of different file types to organize and store sounds. 
Each of these types is briefly described below.

Multis
A Multi is a single, complete setup for the OASYS PCI. It includes all of the 
settings for the Mixer windows, and for the Programs, Patches, and Effects being 
used. The Multi also includes settings for all Program Edit windows, and all 
Control Panel parameters for the Patches and Effects.

To put it another way, Multis store all of the settings in the Mixer, Send Busses, 
Output Busses, Channel Parameters, Program Edit, and Control Panel windows-
everything except for the Preferences and ASIO Control Panel windows. 

For more information, see the “Using Multis” section in the Users Guide.

Programs
Programs are the basic sounds of the OASYS PCI, and must be placed on a Mixer 
Channel to be played. They play one or two Patches, which can be layered or split 
by key and velocity ranges. They also have up to four Insert Effects, which appear 
in the Mixer Channel. Programs store all Control Panel settings for their Patches 
and Effects.

For more information, see the “Using Programs & Patches” section in the Users 
Guide.

Effects-Only Programs
Effects-Only Programs store all of the Insert Effects for a Mixer Channel, including 
all Effects Control Panel parameters. You can use them to load chains of Effects 
into a Mixer Channel, or to store such chains for use elsewhere.

Effects-Only Programs are just normal Programs without any Patches loaded into 
the Patch slots. Unlike normal Programs, Effects-Only Programs can be used on 
any type of input, including Audio Inputs, Streams, or even other Programs.

In the Korg factory voicing, they will be placed in the Programs section of the 
folder named “Korg FX Programs.”

For more information, see the “Using Effects” section in the Users Guide.

Patches
Patches are the basic units of sound creation on the OASYS PCI. They must be 
placed in a Program in order to be played. Each Patch contains its own synthesis 
algorithm, which may be quite different from one Patch to another. The Patch 
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Control Panel allows you to edit the parameters of a Patch; those parameters may 
be very different, depending on the Patch’s synthesis algorithm. 

For more information, see the “Using Programs & Patches” section in the Users 
Guide.

Effects
Effects are used to modify the sound of Patches, Audio Inputs, or Streams. They can 
be used as insert effects in the Mixer Channels and Output Busses, or as send effects 
via the Send Busses. 

Each Effect contains its own audio processing algorithm, which may be quite 
different from one Effect to another. The Patch Control Panel allows you to edit the 
parameters of an Effect; those parameters may be very different, depending on the 
Effect’s synthesis algorithm.

For more information, see the “Using Effects” section in the Users Guide.

Samples
A Sample is an audio file, which can be placed in a Multisample (see below) and 
then played back by sample-based OASYS PCI Patches. OASYS PCI recognizes 16-
bit and 24-bit samples in a number of different formats, including AIFF, WAV, 
Sound Designer II, and Korg’s proprietary .kes format.

For more information, see the “Using Samples & Multisamples” section in the 
Users Guide.

Multisamples
Multisamples are collections of one or more Samples assigned to ranges across the 
keyboard. Each key range has offsets for common parameters, such as volume, pan, 
filter cutoff, decay, and so on, which can be used to adjust Patch parameters 
individually for each Sample. 

For more information, see “Using Samples & Multisamples” section in the Users 
Guide.

OASYS PCI Editor
The OASYS PCI Editor program allows you to control all of the sound production 
and audio processing aspects of the OASYS PCI, including all mixer settings, 
loading of Programs and Effects, and all Program, Patch, and Effects parameters. 

If you are using the OASYS PCI in conjunction with a digital audio program, you 
should leave the OASYS PCI Editor running in the background, so that you can 
switch to it for editing Programs and Effects.

OASYS PCI Engine
The OASYS PCI Engine controls the low-level functions of the OASYS PCI system, 
such as sending and receiving MIDI, playing sounds, and so on. It will 
automatically start up whenever the OASYS PCI is being used, and will 
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automatically quit again when it is not. On MacOS systems, it’s located in the 
System Extensions folder; on Windows systems, it’s located in the 
windows/system directory.

You don’t interact directly with the OASYS PCI Engine itself; instead, you control 
it via the OASYS PCI Editor and any audio and/or MIDI software being used.
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User Interface & Shortcuts
Wherever possible, the OASYS PCI supports standard user interface concepts. 
There are buttons to push, sliders to drag, numerical fields to type in, and so on. 
There are a few items and concepts which bear mentioning, as discussed below.

Volume faders
Double-clicking on a volume fader in a Mixer Channel, Send Bus, or Output Bus 
will set the fader to 0dB (unity gain), a value of 111.

Knobs
Knobs are used in the Mixer windows and the Control Panel. You can move knobs 
by dragging the mouse either up and down, or left and right, as if you were moving 
a slider. They are not designed to be “turned” in a circular motion; doing so will 
produce undesired results! 

For fine control, you can increment and decrement the knob’s value using the up 
and down arrows on the keyboard. You can also type directly into the value box.

Double-clicking on a knob will set it to its 12 o’clock position. For example, double-
clicking on the Mixer’s Pan knobs sets them to 64 (center).

Send knobs are the one exception to this. As with volume faders, double-clicking a 
send knob sets it to 0dB (unity gain), a value of 111.

Value boxes
A value box displays a numerical value, such as a volume level or a filter cutoff. 
You can edit value boxes in several different ways, as described below:

Typing.  You can type directly into the selected value box. Typed edits take effect 
when you press return, tab, or enter; when you click on another value box, or on 
another window; or when you move another knob, slider, button, or menu.

Arrow keys. You can increment and decrement the selected value box by pressing 
the up and down arrow keys on the computer keyboard.

Mouse dragging. You can edit a value box by simply clicking in the box and then 
dragging the mouse up or down, as you were moving a slider. Dragging up 
increments the value, and dragging down decrements the value.

Drag-and-drop
To load Programs, Patches, or Effects, just drag them from the Catalog window into 
the desired slot.

Alternately, you can select a slot, and then double-click on the name of the 
Program, Patch, or Effect in the Catalog window.
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You can also use drag-and-drop to copy Programs, Patches, and Effects between 
slots. Just click on the name of the Program, Patch, or Effect that you’d like to copy, 
and drag it to the new location.

Delete key
Pressing the Delete key will remove the currently selected Program, Patch, or 
Effect from the current Multi or Program.

Bypassing Effects
To bypass a single Effect, click on the slot number to the left of the Effect name. 

To bypass all Effects in a Channel, Send, or Output Bus, option-click (MacOS) or 
CTRL-click (Windows) on any of the Effects slot numbers. 

Clearing clip indicators
To clear a meter’s clip indicators, click on them. To clear all clip indicators on the 
Mixer, option-click (MacOS) or CTRL-click (Windows) on any clip indicator.
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Troubleshooting & Tech Support
For troubleshooting tips, look in the OASYS PCI FAQ

FAQ stands for “Frequently Asked Questions.” The OASYS PCI FAQ, which is 
automatically installed with the OASYS PCI software, contains a complete website 
devoted to troubleshooting, compatibility, and usage tips. 

The FAQ is in HTML format, so that it can be read by any standard web browser, 
such as Netscape Navigator or Internet Explorer. To search through the FAQ, start 
by opening the document named “OASYS PCI_faq_index.htm.”

In addition to the FAQ installed with the OASYS PCI software, the latest version 
can always be found at the Korg website, at http://www.korg.com.

That’s nice, but I can’t start my computer
We sincerely hope that the OASYS PCI will never interfere with your computer 
starting up. If you think this is the case, however, you can try the following:

1. Start up with extensions disabled (MacOS only).

Start with extensions disabled by turning on the computer’s power and then 
immediately holding down the Shift key. Keep holding the Shift key throughout 
the startup process, until the Finder desktop appears.

Once the computer is started properly, you can remove the OASYS PCI extensions 
from the System folder if necessary (or better, disable them using the Extensions 
Manager control panel).

You can then restart with the extensions required for the web browser, and look 
through the OASYS PCI FAQ for a solution.

2. Make sure that the OASYS PCI card is firmly seated in the PCI slot.

If the card is not seated properly, this can interfere with the computer in 
unpredictable ways.

3. If all else fails, physically remove the card from the computer.

This will at least eliminate the possibility that the OASYS PCI is the root of the 
problem.

For technical support, contact your Korg Distributor
Your national Korg Distributor will be pleased to provide technical support for the 
OASYS PCI. There are Korg Distributors in almost every nation on earth. A sheet 
of paper labeled “Korg Distributors List,” included with the OASYS PCI package, 
contains contact information for all Korg Distributors, world-wide.

The current version of the Korg Distributors List is also maintained online, at 
http://www.korg.co.jp/company/distributors.html.
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MIDI Implementation Chart
Korg OASYS PCI Version 2.0 2001 

O: Yes

X: No

Function Transmitted Recognized Remarks

Basic Channel Default
Changed

1-16
1-16

1-16 (A and B)
1-16 (A and B)

Memorized
See Note 1

Mode Default
Messages
Altered

X
************

3
X

Mode 3: Omni Off, Poly

See Note 2

Note Number
True Voice

X
************

0-127
0-127

Note Number “True Voice” is the actual note 
played in response to the MIDI note.

Velocity Note On
Note Off

X
X

O
O

After Touch Key (Poly)
Channel (Mono)

X
X

O
O

Pitch Bend X O

Control Change 01
07
08
10
11
12
13
64
89
90
91
92
93
94
1-95

X
X
X
X
X
X
X
X
X
X
X
X
X
X
X

O
O
O
O
O
O
O
O
O
O
O
O
O
O
O

01 Mod Wheel
07 Volume
08 (Width)
10 Pan
11 Expression
12 Effect Control 1 (FX Send A)
13 Effect Control 2 (FX Send B)
64 Sustain
89 (Mute)
90 (Solo)
91 (Send Mute A)
92 (Send Pre/Post A)
93 (Send Mute B)
94 (Send Pre/Post B)
1-95 Controllers - See Note 3

Program Change
True Number

X
X

X
X

System Exclusive O O

System Common Song Position
Song Select
Tune Request

X
X
X

X
X
X

System Real Time Clock
Commands

X
X

O
O

“Commands” means Start, Continue and 
Stop commands (for use with sequencers).

Aux Messages Local On/Off
All Notes Off
Active Sensing
System Reset

X
X
X
X

X
X
X
X

Notes 1. Basic Channel “Changed” means the channels that are accessible by the user.
2. Mode “Altered” means substitutions used for unimplemented modes. OASYS PCI makes no substitutions.
3. The mod sources “MIDI A-H” allow 8 additional MIDI controller numbers to be recognized as modulation sources.
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Specifications
Analog I/O
Inputs

Inputs: 24-bit, 128x oversampling sigma-delta 
converters

S/(THD+N) Ratio (A weighted): 92dB at 
-0.5dBFS

Dynamic Range: 98dB (typical) @IHF-A

THD+N (A weighted): 0.005% at 1kHz, +16dBu 
Input, 100kOhm load

Frequency Response: 20 Hz - 20 kHz, 
+/- 0.02dB, +4dBu Input, 100kOhm load

Impedance: 100kOhm (calculated)

Outputs

24-bit, 128x oversampling sigma-delta 
converters with 8x digital filters

S/(THD+N) Ratio (A weighted): 93.0 dB at 
-0.5 dBFS

Dynamic Range: 108dB (typical) @IHF-A

THD+N (A weighted): 0.002% at 1kHz, +16dBu 
Input, 100kOhm load

Frequency Response: 20 Hz - 20 kHz, 
+/- 0.09dB, -12.0 dBFS, 100kOhm load

Impedance: 50 Ohm (measured)

General

Nominal Levels: +4 dBu

Headroom: 12 dB

Sample Rates: 44.1 kHz, 48 kHz, external clock

Digital I/O
ADAT optical I/O: 24-bit

S/PDIF coaxial I/O: 24-bit

Word clock I/O: BNC

ADAT Timecode: Input and through

Synthesizers
Synthesizers are plug-ins loaded from disk, 
allowing for easy future expansion.

Initial release includes over 25 synthesis 
algorithms and hundreds of sounds.

Effects
Effects are plug-ins loaded from disk, allowing 
for easy future expansion.

Initial release includes over one hundred unique 
effects algorithms.

Mixer
12 channels, each of which may process 
synthesis programs, audio inputs, or hard disk 
audio tracks. Channels may each have up to 4 
insert effects.

4 send busses, each with up to 4 effects.

6 stereo output busses, each with up to 4 effects.

General
DSP Processing MIPS: 480

PCI revision 2.1 compliant. Requires one full-
length PCI slot.

PCI Power Consumption: +5V = 1.875W, +12V = 
0.294W, -12V = 0.117W

Specifications, operations, and appearance are subject 
to change without notice. 
50 OASYS PCI



Appendix Index

E
nglish
Index
A
ADAT

ADAT sync input and output 13
Input and output 12
Using with ADAT A/D/A converters 35
Using with ADAT mixers 34
Using with ADAT tape machines 35

Analog input and output 11
ASIO, configuring 26
Audio Connectors 11

B
Back Panel Connectors 11

C
Connectors 11

E
Effects 43
Effects-Only Programs 42

F
FAQ website 48
FreeMIDI, configuring 23
FX-Only Programs 42

H
Hardware installation 8

I
Instant gratification 40

M
MacOS

Serial port MIDI setup 17
Software installation 14
Sound Manager, configuring 28
USB MIDI interfaces 17

MIDI
FreeMIDI, configuring 23
MIDI Implementation Chart 49
OMS, configuring 20
Serial Port MIDI Setup 17
USB MIDI interfaces (MacOS) 17

Windows MIDI, configuring 18
MME, configuring 31
Multis 42

O
OASYS PCI Editor 43
OASYS PCI Engine 43
OMS, configuring 20

P
Patches 42
Product support 48
Programs 42

R
Rear Panel Connectors 11

S
S/PDIF

Input and output 12
Using with S/PDIF devices 37

Serial port MIDI setup (MacOS) 17
Shortcuts 45
Software installation 14

MacOS 14
Windows 95/98 15

Sound Manager, configuring 28
Support 48
Sync-see Word Clock 33
System requirements 8

T
Technical support 48

U
USB MIDI interfaces (MacOS) 17
User interface conventions & shortcuts 45

W
Wave devices, configuring 31
Windows 95/98

MIDI, configuring 18
MME (Wave devices), configuring 31
Software installation 15
OASYS PCI 51



Index Appendix

E
ng

lis
h

Word clock 33
A few words on word clock 38
Setting the word clock source 33
Word clock input and output 13
52 OASYS PCI


	Contents
	Introduction
	OASYS PCI
	Thank you!
	State of the art DSP synthesis
	Incredible effects processing
	Professional, multi-format analog and digital I/O
	Seamless integration with MIDI and digital audio software
	Designed to collaborate with your CPU
	Complete automation via MIDI

	About The Manuals
	Installation Guide
	Users Guide
	Patches and Effects Guide
	OASYS PCI FAQ


	Installation and Setup
	Hardware Installation
	Unpacking
	System Requirements
	Handle carefully!
	Installing the OASYS PCI card in your computer

	Audio Connectors
	Software Installation
	Installing the OASYS PCI software for MacOS
	Installing the OASYS PCI software for Windows 95/98

	Serial Port MIDI Setup (MacOS)
	MIDI Setup (Windows)
	Using the OASYS PCI with Windows MIDI programs
	Using the OASYS PCI Editor as a stand-alone MIDI program

	Configuring OMS (MacOS)
	Installing the OASYS PCI OMS Driver
	Selecting OMS as the OASYS PCI MIDI system
	Adding the OASYS PCI to the OMS Studio Setup
	Using the OASYS PCI with an OMS sequencer
	Using the OASYS PCI Editor as a stand-alone OMS program

	Configuring FreeMIDI (MacOS)
	Installing the OASYS PCI FreeMIDI Driver
	Selecting FreeMIDI as the OASYS PCI MIDI system
	Adding the OASYS PCI to the FreeMIDI setup
	Using the OASYS PCI with Performer and Digital Performer
	Using the OASYS PCI Editor as a stand-alone FreeMIDI program

	Configuring ASIO Software
	Installing the OASYS PCI ASIO driver
	Selecting the OASYS PCI as the ASIO device
	Read the FAQ for more information on specific ASIO programs
	Setting the sample rate and word clock source
	More information on using ASIO

	Configuring Sound Manager (MacOS)
	Sound Manager setup

	Configuring MME (Windows)
	Using the OASYS PCI as multiple wave devices
	Wave device numbering
	Setting the default playback or recording device

	System Configurations
	Word clock and sample rate settings
	Setting the word clock source in the OASYS PCI Editor
	Setting the word clock source in digital audio software
	Using only the OASYS PCI’s analog input and output
	Using the OASYS PCI with ADAT-compatible digital mixers
	Using the OASYS PCI with ADAT-compatible A/D and D/A converters
	Using the OASYS PCI with ADAT-compatible tape machines
	Using the OASYS PCI with S/PDIF devices (DAT, effects, etc.)
	A few words on word clock


	Getting Started
	Instant Gratification
	Loading and playing Multis

	What are...?
	File Types
	OASYS PCI Editor
	OASYS PCI Engine

	User Interface & Shortcuts
	Volume faders
	Knobs
	Value boxes
	Drag-and-drop
	Delete key
	Bypassing Effects
	Clearing clip indicators


	Appendix
	Troubleshooting & Tech Support
	For troubleshooting tips, look in the OASYS PCI FAQ
	For technical support, contact your Korg Distributor

	MIDI Implementation Chart

	Index

